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על הספר
המדריך העברי החדש לתוכנת אינדיזיין נכתב על ידי שתי אוהדות אינדיזיין מושבעות, עבור משתמשי ואוהבי אינדיזיין 

אחרים - בהווה ובעתיד )אחרי שיסיימו לקרוא את הספר(. 

פרקי הספר מסודרים כך שפרק נבנה על התוכן הקיים בקודמיו, לכן מומלץ לעבור עליו בסדר הכרונולוגי של 
הפרקים. אם בכל זאת אתם מחפשים נושא מסויים, תוכלו להיעזר בתוכן העניינים המפורט שבתחילת הספר או 

באינדקס המילולי שבסופו.

הספר מיועד למי שמכיר לפחות תוכנת מחשב אחת )לאו דווקא תוכנה גרפית(, ולכן אין הסברים מפורטים על 
פקודות בסיסיות כמו שמירה, פתיחת קבצים או סיום העבודה בתוכנה.

תוכנו של הספר תואם את גירסאת אינדיזיין CC העדכנית ליום הוצאתו )2021(. אנו ממליצות לבקר בבלוג באתר 
מנטור )www.mentor.co.il/blog( לעדכונים שוטפים שיתבצעו בעתיד באינדיזיין ובשלל תוכנות נוספות.

ולסיום, הספר מתאים למשתמשי מקינטוש או חלונות כאחד.

Windows הערה למשתמשי 	g

החלונות המצולמים בספר צולמו ממחשבי מקינטוש, אך הספר מיועד למשתמשי מחשבים מכל הסוגים.

החלונות במערכות ההפעלה השונות זהים לחלוטין בתוכנם וכמעט זהים בנראותם )אדובי עשתה מאמצים גם 
ביצירת ממשק אחיד(. 

ההבדל המרכזי בין מערכות ההפעלה הוא שמקש Command במקינטוש זהה בפעולתו למקש Control בחלונות, 
ומקש Option במקינטוש הוא מקש Alt בחלונות, ושבכל זאת התוכנה נראית טוב יותר במקינטוש. אבל זה כבר 

עניין של טעם...

שניה לפני שמתחילים 	g

בעיני רבים אינדיזיין היא תוכנה "טכנית", לא סקסית כמו פוטושופ או חמודה כמו אילוסטרייטור. אחרי שבילינו 
בחברתה לא מעט שנים, אנחנו יכולות להגיד בבטחון מלא - כן, היא טכנית, אבל היא לא פחות ממופלאה ועובדת 
בשביל המשתמש, ולא להיפך, ובכיף )אם רק מבקשים יפה ונכון(, ואת זה ניסינו להעביר בספר )מקוות שגם הצלחנו(.

המחשבה שליוותה אותנו לאורך כל כתיבת הספר היא "מה צריך לדעת באינדיזיין כדי להתחיל לעבוד", ולכן הספר 
כתוב עבור משתמש מתחיל, מי שאין לו ניסיון באינדיזיין או בכל תוכנת עימוד אחרת. ולמשתמשים המנוסים שבינינו, 
אנו בטוחות שתמצאו הרבה טיפים, חידושים ושיטות עבודה מתקדמות ויעילות שלא יצא לכם להכיר ושאנו מאמינות 

שכל משתמש אינדיזיין חייב לדעת. 

עם זאת, התוכנה עצומה בהיקפה, לכן הספר אינו כולל את כל מה שיש לאינדיזיין להציע. מי יודע, אולי יום אחד, נכתוב 
גם ספר על האפשרויות המתקדמות ביותר שלה...

ט.ל.ח 	g

למי שאינו מכיר את ראשי התיבות ט.ל.ח: טעות לעולם חוזר.

הספר עבר, במהלך הכתיבה, הגהות רבות על ידי אנשי מקצוע בתחום התוכנה, ההדרכה והעריכה הלשונית, אולם, 
מנסיוננו אנו יודעות שגם לאחר אין סוף הגהות, עדיין מסתתרת אי-שם טעות שלא ראינו. נשמח לקבל הערות, הארות 
office@mentor.co.il :והצעות ייעול בכל הקשור לתוכן, לדוגמאות המשולבות בספר, לצורת העריכה ובכלל, בכתובת

אז קדימה! לעבודה.
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פרק 7 / צבע ואפקטים

צבע באינדיזיין
היות ומדובר בתוכנה המיועדת להכנת קבצים לדפוס ומסכים לאתרי אינטרנט או אפליקציות, ברור שלאינדיזיין 
יש לא מעט דרכים להתמודד בצורה טובה עם השגעונות העיצוביים והטרנדים האחרונים בתחום. זו הסיבה שאנו 

מקדישות פרק שלם לנושא הצבע - יצירת צבעים, ניהול צבעים והפקה.

חלונות לניהול צבע
היות וצבע הוא מרכיב עיקרי בכל עיצוב, אנשי אדובי דאגו שיהיה לנו יותר מחלון אחד בו נוכל ליצור צבע חדש 

וכמובן גם לאחסן אותו.

,Window - Color בתפריט  למצוא  אפשר  החלונות  כל   את 
רק כדאי להבין את ההבדלים ביניהם כדי לפתוח את החלון הנכון:

	●)Swatches( חלון דוגמיות צבע
	●)Color( חלון צבע
	●)Gradient( חלון מעברי צבע
Adobe Color Themes - אם אתם מחפשים את החלון הזה, אז בצער אנו מבשרות כי ממש בימים אלה הוא ●	

 color.adobe.com :שכתובתו Adobe Color מוסר מהתוכנה. כתחליף אפשר לגלוש לאתר הצבע של אדובי
בו ניתן ליצור קבוצות צבעים עפ״י תיאוריות הצבע השונות ועוד.

כאשר מדובר בבחירת צבע עבור מילוי צורה, הגדרת צבע קו מתאר או צבע מלל, ניתן לעשות זאת גם מחלון 
Properties ומבורר הצבעים בתחתית חלון הכלים.

)Swatches( חלון דוגמיות צבע)Color( חלון צבע)Gradient( חלון מעברי צבע

color.adobe.com
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)Swatches( חלון דוגמיות הצבע 	g

כאשר יוצרים צבע חדש, וגם כאשר דוגמים צבע, מומלץ מאד לשמור אותו לשימוש עתידי ולעריכה עתידית. חלון 
Swatches הוא המקום בו נשמרים הצבעים והוא מכיל את כל הצבעים בהם עשיתם שימוש בקובץ עליו אתם 

עובדים כעת. 
הצבעים באינדיזיין הם גלובאליים, מה שאומר שעריכת צבע תעודכן אוטומטית בכל המופעים שלו במסמך.

החלון מאפשר יצירת צבע חדש )במספר מודלים של צבע(, שמירת צבע אחיד ומעבר צבעים, מחיקת צבעים או 
החלפתם ועוד. בקיצור - החלון השימושי ביותר מבין חלונות ניהול הצבע.

	1 צבע מילוי/קו - כאשר הריבוע המלא מונח מלפנים )  (, הצבע יוענק למילוי הצורה או המלל המסומנים. .
כאשר הריבוע החלול מונח מלפנים )  (, הצבע יוענק לקו המתאר של הצורה או המלל המסומנים. לחיצה 

על אייקון החץ הכפול שלידם תהפוך את צבע המילוי לצבע קו המתאר ולהיפך. 

	2 צבע צורה/מלל - כאשר מדובר בצביעה של צורה המכילה מלל, ניתן להתייחס לצביעת הצורה עצמה ולצביעת .
המלל שבתוכה, בנפרד. כאשר הריבוע )משמאל לאות T( הוא זה שפעיל, צבע המילוי או הקו יוענק לצורה )או 
לקו המתאר שלה(. כאשר האות T היא הפעילה )  (, צבע המילוי או הקו יוענק למלל שבתוך הצורה. ניתן 

לראות שכאשר מסמנים מלל בתוך תיבה כפתור ה-T מסתמן אוטומטית.

	3 גוון )Tint( - כאשר הצבע מוצג ב-100% הוא מוצג כצבע מלא. ניתן לבחור גוון של הצבע )בהיר יותר מהמקור(, .
כאשר מסמנים את הצבע ומזינים ערך נמוך מ-100%. ניתן גם ללחוץ על המשולש שמימין לשדה הערך. כעת, 

באמצעות הזזה של המכוון שמאלה, ניתן לקבוע את הערך הרצוי.

	4 רשימת דוגמיות הצבע - באזור זה מופיעות דוגמיות הצבע שנוצרו במסמך. כל מסמך חדש מכיל 10 דוגמיות .
צבע כברירת מחדל. ששת הצבעים התחתונים - ניתנים לעריכה ולמחיקה.

ארבעת הצבעים העליונים אינם ניתנים למחיקה ורק אחד מהם ניתן לעריכה. מימין לאלו שלא ניתנים לעריכה 
: יופיע האייקון 

None - ללא צבע. בדפוס אין שקוף, לכן בכל מקום בו בחרתם להשתמש בצבע None, יוצג צבע הנייר ●	
עליו העבודה מודפסת. ״צבע״ זה אינו ניתן לעריכה.

Paper - צבע הנייר עליו מיועדת העבודה להיות מודפסת. ברירת המחדל עבורו היא לבן, מכיוון שלרוב ●	
מדפיסים על נייר לבן. ניתן לערוך את הצבע הזה בהתאם לצבע הנייר עליו תודפס העבודה כדי לראות את 

ההשפעה הצבעונית על העיצוב. למשל, מוספים כלכליים מודפסים על נייר ורדרד ולא לבן.
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Registration - זהו סוג של שחור המורכב מכל ארבעת צבעי היסוד של הדפוס )סיאן, מג׳נטה, צהוב ●	
ושחור(, ומצבעי הספוט במסמך, במידה ויש כאלו. למעשה, צבע זה מיועד לשימוש עבור סימני דפוס, כמו 
סימון קיפול או חיתוך, כך שכאשר הקובץ ישלח להדפסה - סימני הדפוס יופיעו בכל אחד מלוחות הדפוס. 

צבע זה אינו ניתן לעריכה.
Black - צבע שחור. כנראה הצבע השימושי ביותר. זהו שחור ״נקי״ המורכב מ-100% שחור בלבד. אינו ניתן ●	

לעריכה.

	5 הוספת דוגמית צבע לספריית הענן הפעילה..

	6 תצוגת דוגמיות הצבע בחלון - לחיצה על כפתור זה תפתח תפריט המכיל .
אפשרויות שונות לתצוגת הצבעים בחלון:

הצג את כל הצבעים )Show All Swatches( - החלון יציג את כל סוגי ●	
הצבעים וקבוצות הצבעים שנוצרו.

הצג דוגמיות צבע )Show Color Swatches( - אפשרות זו תציג בחלון רק צבעים אחידים וקבוצות צבעים.●	

הצג מעברי צבעים )Show Gradient Swatches( - אפשרות זו תציג בחלון רק מעברי צבעים וקבוצות ●	
צבעים.

הצג קבוצות צבעים )Show Color Group( - אפשרות זו תציג רק את קבוצות הצבעים שהוגדרו. הטיפ ●	
שלנו - אם יש לכם המון צבעים בחלון Swatches, הציגו רק את אלו איתם אתם עובדים בעיקר. אם החלון 

אינו מכיל הרבה צבעים, התצוגה הראשונה היא הנוחה ביותר.

	7 קבוצת צבעים )Color Group( - קובץ יכול לכלול עשרות צבעים )מנסיון(, מה .
שהופך את תצוגת הצבעים בחלון Swatches לארוכה )ומעייפת(. אחת הדרכים 
הטובות ביותר לניהול הצבעים בחלון הוא יצירת תיקייה עבור קבוצות צבעים. 
לדוגמה, תיקייה עבור צבעי הלוגו של החברה או תיקייה עבור צבעי טבלה וכן הלאה.

בחירת צבעים בחלון ואז לחיצה על הכפתור, תיצור תיקייה מקבוצת הצבעים ●	
הכוללת בתוכה את הצבעים שנבחרו.

בחירת פריט במסמך ואז לחיצה על כפתור הקבוצה החדשה בחלון, מציגה חלון יצירת קבוצה חדשה בו ניתן ●	
לבחור בין שתי אפשרויות: צבעים שסומנו בחלון או פריטים שסומנו ברחבי המסמך. בראש חלון זה אפשר 
)וכדאי!( להקנות שם )הגיוני( לקבוצת הצבעים. לאחר אישור החלון, תוצג תיקייה ובה הצבעים שסומנו/צבעי 
הפריטים שסומנו. במידה ונבחרה האפשרות ליצור קבוצה מצבעים שסומנו בחלון Swatches, הצבעים 
יעברו אל תוך התיקייה. במידה ונבחרה האפשרות לצבעי פריטים, הצבעים יועתקו לתוך התיקייה ויישארו 

גם ברשימה הכללית.
חשוב לדעת כי בכל שלב ניתן לגרור צבעים לתוך תיקייה כזו וגם להוציא ממנה צבעים שאינם רלוונטים ●	

עוד. כדי למחוק תיקיית קבוצת צבעים, יש לסמן את התיקייה בחלון וללחוץ על כפתור הפח שבתחתית 
החלון. במידה והתיקייה מכילה צבעים בהם נעשה שימוש במסמך הנוכחי, תוצג ההודעה בנוגע להחלפת 

הצבעים שימחקו.

	8 צבע חדש )New Swatch( - רוצים ליצור צבע חדש? לחיצה על כפתור זה משכפלת את הצבע שמסומן .
כעת בחלון.
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	9 לשמו של הצבע המשוכפל נוספת המילה copy )כדי שתדעו שמדובר בהעתק(. לחיצה כפולה על הצבע המשוכפל .
 )Color Mode( מודל צבע ,)Color Type( פותחת חלון בו ניתן להגדיר מחדש את שם ומרכיבי הצבע: סוג
ואחוזי צבע מכל צבע בסיס. סימון האפשרות Name with Color Value שבראש החלון, תציג את שמו בהתאם 
לאחוזי הצבעים המרכיבים אותו. ביטול הסימון יאפשר לקרוא לצבע בכל שם הולם )כמו ״צהוב חלמון״, ״ירוק 

דשא״ או ״אדום אש״(.

פח זבל - בחירת צבע או מספר צבעים בחלון הצבעים ואז לחיצה על 10	.
כפתור הפח, תסיר את הצבע מרשימת הצבעים בחלון. במידה והצבע נמצא 
בשימוש במסמך, יוצג חלון הנותן שתי אפשרויות לגבי הפריטים הצבועים 
בצבע המועמד להסרה: החלפת צבע הפריטים בצבע אחר מהרשימה או 

יצירת צבע חלופי שכעת אינו ברשימת הצבעים.

תווית סוג הצבע - התווית מעידה על מהות הצבע - האם הוא צבע פרוצס )משמע, צבע שנוצר משילוב של צבעי 11	.
 . הדפוס היסודיים CMYK( המסומן באייקון  או צבע ספוט )צבע מיוחד, לדוגמה פנטון( ואז יסומן באייקון 

תווית מודל הצבע - כברירת מחדל, במסמך חדש שהוגדר עבור דפוס, הצבעים יוצגו במודל CMYK, ובמסמך 12	.
חדש שהוגדר עבור אינטרנט או מובייל, הצבעים יוצגו במודל RGB. בצידו הימני של כל צבע ניתן לראות ריבוע 
. עוד על מודל צבע והמרת   LAB /  RGB /  CMYK :קטן וצבעוני, המציג את מודל הצבע של אותו צבע

מודל צבע, בהמשך פרק זה.

Swatches תפריט חלון 	g

לחיצה על כפתור התפריט בחלקו הימני-עליון של החלון, מציגה 
תפריט מלא באפשרויות שונות ומשונות, וכאן נעבור על המרכזיות 

שבהן:

	1 . New( חלקו העליון של התפריט מאפשר יצירת צבע חדש
 )New Tint Swatch( יצירת גוון חדש ,)Color Swatch

.)New Gradient Swatch( ויצירת מעבר צבעים חדש

בחירה בכל אחת מהפקודות פותחת חלון המאפשר יצירת 
צבע חדש, גוון או מעבר צבעים.

	2 נוספות מאפשרות ליצור קבוצת צבעים חדשה . פקודות 
קיימת  צבעים  קבוצת  )New Color Group(, שכפול 
)Duplicate Color Group( על שלל צבעיה )לאחר מכן, הסרת 
צבע או עריכתו מאחת הקבוצות - אינה משפיעה על הקבוצה 
 ,)Delete Color Group( מחיקת קבוצת צבעים ,)השניה
פיזור קבוצת צבעים והחזרת הצבעים לרשימה הכללית 

.)Ungroup Color Group(

	3 צבעים . קבוצת  צבע/אפשרויות  אפשרויות  הפקודה 
)Swatch Options/Color Group Options( זמינה בהתאם 

לצבע/קבוצת הצבעים שנבחרה בחלון. בחירת קבוצת צבעים ואז בחירה בפקודה זו, תציג חלון בו ניתן לשנות 
את שם הקבוצה. הפקודה זהה ללחיצה כפולה על שם הקבוצה בחלון.

בחירה בצבע מתוך הרשימה ואז בפקודה זו, מציגה את חלון עריכת הצבע ומאפשרת לעדכן אותו, לשנות את 
שמו, את מודל הצבע ועוד.

	4 מצא צבע זה )Find this Color( - סימון צבע בחלון ובחירה בפקודה זו תפתח את חלון החיפוש וההחלפה .
)Find/Change( באמצעותו ניתן למצוא כל פריט עליו מוחל הצבע הנבחר, ואם רוצים - גם להחליפו בצבע אחר, 
כך שכל הפריטים הצבועים בו יקבלו את הצבע החדש בו זמנית. הסבר מפורט על חלון Find/Change בפרק 15.
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	5 טען צבעים )Load Swatches( - לאינדיזיין כמה אפשרויות לשמור קבוצות צבעים. אחת מהן היא .
יצירת ספריית צבעים אישית, עליה יוסבר בסעיף הבא. באמצעות פקודה זו ניתן לטעון את קבוצת 
הצבעים שנשמרה בקובץ ספרייה למסמך הנוכחי. פקודה זו מאפשרת גם לטעון צבעים ממסמך אחר. 

הבחירה בפקודה תפתח חלון בו ניתן לאתר את הספרייה האישית או את המסמך ממנו רוצים לטעון את הצבעים. 
אחרי האיתור ואישור החלון, הצבעים שבספרייה או במסמך יתווספו לחלון דוגמיות הצבע. 

	6 שמור צבעים )Save Swatches( - פקודה זו מאפשרת לשמור קבוצה של צבעים כקובץ ספרייה עצמאי, אותו .
ניתן לטעון לכל מסמך אינדיזיין כמו גם למסמכי התוכנות אילוסטרייטור ופוטושופ. בחירה של קבוצת צבעים 
בחלון הדוגמיות ובחירה בפקודה זו תפתח חלון שמירה בו ניתן לבחור במיקום קובץ הצבע שייווצר. בחירה 
במיקום ואישור החלון ייצור קובץ עם סיומת  Adobe Swatches Exchange( ASE( אותו ניתן לטעון לקובץ 

אחר בכל אחת מהתוכנות שהוזכרו.
בספרייה כזו ניתן לשמור רק צבעים אחידים )אין אפשרות לשמור גוונים ומעברי צבע(.●	
	● )Color Mode במידה ורוצים שהספרייה תופיע בספריות המוצעות בחלון עריכת הצבע )בתפריט המשנה

.Swatch Libraries יש לשמור אותה בתיקיית

	7 בחר את כל הצבעים בהם לא נעשה שימוש )Select All Unused( - זוהי פקודה חשובה מאד לשמירה על .
סדר בחלון דוגמיות הצבע. במהלך העבודה יתכן ותיצרו צבעים רבים, תייבאו אובייקטים מקובץ אחר שיוסיפו 
צבעים לחלון ובסופו של דבר - תהיה רשימת צבעים ארוכה מאד בחלון Swatches, ובחלק מהצבעים כלל לא 
יהיה שימוש. כדי לעבוד בצורה מסודרת ולמנוע תקלות אפשריות בדרך, מומלץ ״לנקות״ את החלון מדי פעם 
מכל אותם צבעים בלתי שימושיים. פקודה זו מסמנת בחלון Swatches את כל הצבעים בהם לא נעשה שימוש. 

השלב הבא הוא ללחוץ על כפתור הפח בתחתית החלון על מנת להיפרד מהם לנצח.

	8 הוסף צבעים ללא שם )Add Unnamed Colors( - פקודה הפוכה לפקודה הקודמת וגם היא שימושית מאד. .
כאשר דוגמים צבע באינדיזיין בזמן שפריט כלשהו מסומן, הפריט נצבע בצבע הנדגם אך הצבע אינו מתווסף 
אוטומטית לרשימת הצבעים בחלון Swatches.  אנו ממליצות מאד להוסיף כל צבע שנעשה בו שימוש במסמך 
לרשימת הצבעים )באמצעות סימון הפריט הצבוע בצבע הנדגם ולחיצה על כפתור הפלוס שבתחתית החלון( 

על מנת שניתן יהיה לערוך אותו בעתיד.

אבל נאמר שלא שמעתם לעצתנו ודגמתם צבעים רבים מבלי להוסיפם לרשימה, ובשלב מסויים אתם חווים 
חרטה עמוקה ורוצים לתקן את המעוות. כדי להוסיף אותם לרשימה, כל שעליכם לעשות הוא לבחור בפקודה 

.Swatches-זו והצבעים ״הנסתרים״ יופיעו כולם באחת בחלון ה
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	9 .Large List/Small List/Small Thumbnail/( רשימה גדולה/רשימה קטנה/דוגמיות קטנות/דוגמיות גדולות
Large Thumbnail( - אפשרויות אלו קובעות איך יוצגו הצבעים בחלון Swatches. ברירת המחדל היא רשימה 

גדולה. 

)Color( חלון צבע 	g

.Window > Color > Color בחלון זה ניתן ליצור צבע חדש או לערוך צבע קיים. גם את החלון הזה ניתן לפתוח מתפריט
.)CMYK או RGB( מודל הצבע בחלון יהיה בהתאם למודל הצבע של המסמך

	1 צבע מילוי/קו - זהה לאפשרויות בחלון דוגמיות הצבע המפורט בתחילת הפרק..

	2 צבע צורה/מלל - זהה לאפשרויות בחלון דוגמיות הצבע המפורט בתחילת הפרק..

	3 ..)CMYK( או אחוזים )RGB( מכווני צבעי מודל הצבע וערכי כל צבע במספרים

	4 אזהרת טווח צבע )עבור דפוס( - גרירת המכוונים השונים תשנה את הצבע, עד לקבלת הצבע הרצוי. במידה .
והקובץ מיועד לדפוס, יש לשים לב שאזהרת טווח צבע )משולש צהוב ליד דוגמית הצבע( מעידה על כך שהצבע 
נמצא מחוץ לטווח צבעי הפרוצס )CMYK( וכתוצאה מכך צבע כזה יודפס בגוון שונה )מעט או הרבה, תלוי 

במידת החריגה מהטווח( מזה המוצג על המסך.

	5 פס הצבעים ממנו ניתן לבחור צבע. ברגע שממקמים את הסמן מעל הפס הוא הופך לטפטפת דגימה..

	6 מספר הצבע בערך הקסדצימלי )בתמונה bbef00#( - מיועד בעיקר לעבודה לאינטרנט ומופיע רק בצבעים .
.)Hue Saturation Brightness( HSB-ו RGB במודל

תצוגת דוגמיות קטנות תצוגת דוגמיות גדולות
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Color תפריט חלון 	g

לחיצה על כפתור התפריט בצידו הימני-עליון של החלון ●	
מציגה את תפריט החלון. בתפריט ניתן לבחור את מודל 
הצבע הרצוי: Lab )תצוגת מסך בלבד(, CMYK )דפוס 
בלבד(, RGB )תצוגת מסך והיום גם דפוס דיגיטלי משתמש 

בו כמודל צבע לפעמים(.

מכווני הצבעים ישתנו בהתאם למודל הצבע שנבחר.
הוסף לחלון דוגמיות צבע )Add to Swatches( - פקודה ●	

.Swatches זו תוסיף את הצבע החדש לחלון

דרך נוספת להוסיף את הצבע החדש לחלון Swatches היא לגרור את דוגמית הצבע מחלון Color אל חלון 
Swatches. אפשרות זו דורשת כי שני החלונות יהיו זמינים.

הסתר אפשרויות )Hide Options( - פקודה זו תסתיר את המכוונים השונים בחלון.●	

Color יצירת גוון באמצעות חלון 	g

גוון הוא למעשה צבע בהיר מצבע המקור )ערבוב של לבן עם צבע המקור(. 
לדוגמה, אפור הוא גוון של שחור.

בחירת צבע בחלון Swatches תציג בחלון Color פס בודד ובו מעבר מהצבע 
המלא עד לצבע לבן. בחירה באחוז נמוך מ-100% יוצרת גוון של אותו צבע.

כדי לקבל את הגוון הרצוי, אפשר לגרור את המכוון מתחת לצבע או להקליד 
את האחוז הרצוי בשדה המלל.

לסיום, מומלץ לבחור בפקודה Add to Swatches מתפריט החלון על מנת 
לשמור את הגוון בחלון Swatches. שמו של הצבע יהיה כשמו של צבע המקור בתוספת האחוז שנקבע לגוון.

דרך נוספת ליצירת גוון היא באמצעות שדה Tint בחלון Swatches כפי שהודגם בתחילת הפרק.

הבהרה או הכהייה של צבע קיים 	g

כאמור, גוון )Tint( הוא הבהרה של צבע קיים. ומה אם רוצים ליצור צבע חדש וגירסה כהה ובהירה שלו?

ובכן, ראשית יש ליצור את הצבע המקורי ולשמור אותו. כעת, יש להחזיק את מקש Shift ולגרור את אחד המכוונים 
ימינה )להבהרה( או שמאלה )להכהייה(, על מנת ליצור את הצבע הרצוי.

הצבע המקורי לאחר הבהרהלאחר הכהייה
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)Color Picker ( יצירת צבע חדש באמצעות בוחר הצבע 	g

זו אולי הדרך הקלה ביותר להגדיר צבע חדש:
בתחתית חלון הכלים ניתן להגיע ל-Color Picker, באמצעות לחיצה כפולה על ריבוע צבע המילוי או 

הקו. 

	1 כל חלקו השמאלי של החלון ״מוקדש״ לתצוגת הצבע - את סמן הכוונת אפשר לגרור בתוך התצוגה, עד לקבלת .
הצבע הרצוי.

	2 מימין לתצוגת הצבע מוצג סרגל שגרירתו )מטה או מעלה( משנה את הצבעוניות ומאפשרת לבחור צבעים נוספים..

	3 חלקו הימני של החלון מאפשר להגדיר צבע בהתאם לערכים ידועים באחד מהמודלים הבאים - CMYK )דפוס(, .
RGB )מסך(, Lab )מסך( או הקסדצימל # )אינטרנט(.

	4 מעל לערכים אפשר לראות דוגמת צבע מפוצלת - החלק העליון הוא הצבע החדש, החלק התחתון מציג את .
הצבע המקורי.

	5 לחיצה על כפתור Add CMYK Swatch מוסיפה את הצבע לחלון Swatches. שם הכפתור משתנה בהתאם .
למודל הצבע שנערך. כלומר, אם בוצעה עריכת צבע בערכי CMYK, זה יהיה מודל הצבע בו הוא יישמר.

)Gradient ( חלון מעברי הצבעים 	g

מעבר צבע כשמו כן הוא - מעבר מצבע אחד לצבע אחר.
באינדיזיין ניתן ליצור מעבר צבעים מעגלי )Radial(, בו הצבע השמאלי יהיה מרכז המעבר וינוע אל הצבע הימני, 

ומעבר צבעים קווי )Linear(, בו הצבעים יהיו בהתאם לסדר בו מוקמו בחלון.

על מנת להציג את חלון מעבר הצבעים )Gradient( אפשר לבחור באפשרות Window - Color - Gradient או 
ללחוץ פעמיים על כלי מעבר הצבעים בחלון הכלים )  (.

מעבר צבעים קווימעבר צבעים מעגלי
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בחלון מעבר הצבעים, מצד שמאל-למעלה, ממוקם ריבוע התצוגה המקדימה של מעבר הצבעים.●	
לימינו ממוקם תפריט ממנו אפשר לבחור את סוג המעבר )Type( - קווי או מעגלי.●	
בשדה Location מגדירים את מיקום הצבע במעבר.●	
	●.)Angle( במידה ונבחר מעבר קווי, ניתן לבחור את זווית המעבר
בכפתור Reverse ניתן להפוך את כיוון מעבר הצבעים )יתחיל מהצבע הימני ולא השמאלי במעבר קווי ויתחיל ●	

מהצבע הפנימי ולא החיצוני במעבר מעגלי(.
פס הצבעים )Gradient Ramp( באמצעותו מוסיפים צבעים למעבר ושולטים במיקומם.●	

יצירת מעבר צבעים 	g

ישנן מספר דרכים ליצירת מעבר צבע. הדרך היעילה והמסודרת שבהן, בה אנו ממליצות להשתמש, היא יצירת 
מעבר חדש באמצעות חלון דוגמיות הצבע. לפני יצירת המעבר החדש מומלץ שיהיו בחלון דוגמיות הצבע הצבעים 

בהם נרצה להשתמש במעבר.

	1 ..New Gradient Swatch יש לבחור בפקודה Swatches-בתפריט חלון ה

	2 בחלון שנפתח ניתן לתת שם למעבר הצבעים החדש ולבחור בסוג המעבר )קווי או מעגלי(..

	3 כברירת מחדל, פס הצבעים )ה״רמפה״( יהיה מורכב מסטופר )דוגמית צבע שעל הפס( שחור בצד אחד וסטופר .
לבן בצד שני. 

 Stop Color על מנת לשנות צבע של סטופר יש ללחוץ עליו ובתפריט המשנה
לבחור בדרך יצירת הצבע: 

במידה ותבחרו באחד ממודלי הצבע תתקבל אפשרות להרכבה עצמית של צבע 
בהתאם למודל הנבחר: CMYK / Lab / RGB / HSB. במידה ותבחרו ברשימת 

ה-Swatches תוצג רשימת דוגמיות הצבע מהן אפשר לבחור. 
	4 על מנת להוסיף צבע למעבר יש להקליק בשטח שבין הסטופרים. סטופר חדש יופיע וניתן ללחוץ עליו ולבחור .

את הצבע עבורו.

	5 להסרת סטופר יש ללחוץ עליו ולגרור אותו אל מחוץ לשטח הרמפה..
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	6 לשינוי מיקום של סטופר יש ללחוץ עליו ולגרור אותו ימינה או שמאלה לרוחב הרמפה. ניתן גם לסמן סטופר .
.)Location( ולתת לו מיקום מדויק על ידי הזנת ערך בשדה המיקום

כאשר בוחרים סמן צבע, המיקום הוא בהתאם לרוחב פס הצבע - בין 0%-100%. כאשר בוחרים את מיקום מעבר 
הצבע, המיקום הוא יחסית למיקום בין שני צבעים. לדוגמה, אם נרצה מעבר שיתחיל בצבע ירוק ויסתיים בצבע 
צהוב, נמקם את הצבע הירוק במיקום 0% ואת הצהוב במיקום 100%. אם נרצה שהמעבר ביניהם יתרחש בדיוק 

באמצע, נבחר את המעוין שמעל פס הצבע ונקבע את המיקום שלו ל-50%.
	7 . .Add במידה ורוצים לאשר את מעבר הצבע אך להישאר בחלון ליצירת מעבר צבע נוסף, ניתן ללחוץ על כפתור

.Swatches-מעבר הצבע החדש יופיע כעת ברשימת ה .OK לאישור החלון יש ללחוץ על כפתור

עריכת מעבר צבעים 	g

אחרי הוספת דוגמית מעבר הצבעים החדשה לרשימת ה-Swatches, ניתן 
לערוך אותה באמצעות לחיצה כפולה, הפותחת את חלון אפשרויות מעבר 

הצבע, הזהה כמעט לחלון יצירת דוגמית מעבר צבעים חדשה.
עריכה באמצעות חלון זה תשנה את דוגמית מעבר הצבעים ותעדכן בשינוי 

כל פריט שנצבע בדוגמית זו באופן גלובאלי.

 Gradient ניתן לערוך את מעבר הצבעים גם באופן פרטני באמצעות חלון
כאשר בוחרים בפריט עליו הוחל מעבר הצבעים, אך עריכה זו תשפיע על 

פריט זה בלבד.

בחלקו העליון של פס מעבר הצבעים, אפשר לראות סמן מעוין בין כל שני 
צבעים - סמן זה מסמן את נקודת המעבר בין צבע אחד לשני.

כברירת מחדל, הסמן נימצא בדיוק באמצע )בין שני צבעים(. גרירת הסמן 
ימינה או שמאלה משנה את אופן מעבר הצבעים בצורה מאד משמעותית.
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כלי מעבר הצבעים 	g

בשונה מצבע אחיד, למעבר הצבעים יש כלי משלו בחלון הכלים. כלי Gradient מאפשר לקבוע היכן יתחיל ויסתיים 
מעבר הצבעים )רמז, הוא לא חייב להתחיל מקצה הצורה או ממרכזה(.

 Gradient-על מנת לקבוע היכן יתחיל ויסתיים מעבר הצבעים בפריט מסוים, יש לסמן את הפריט, לבחור בכלי ה
ובאמצעות לחיצה וגרירה למתוך קו מהנקודה בה רוצים שיתחיל המעבר ועד לנקודה בה רוצים שיסתיים. ניתן 

להתחיל לגרור את תחילת המעבר או לסיים את הגרירה גם מחוץ לתחומי הצורה. 

ניתן גם להחיל מעברי צבע על קו המתאר של הפריט ולשחק עם כיוון ונקודות הפתיחה והסיום של המעבר באמצעות 
כלי מעבר הצבעים:
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צבע - לדפוס ולדיגיטל
כבר בתחילת העבודה כדאי לדעת לאיזו מדיה התוצאה הסופית מיועדת - למדיה דיגיטלית )מסכים, אתר אינטרנט, 

אפליקציה, מצגת( או לדפוס: אופסט או דיגיטלי.

 ,CMYK או RGB ולדפוס דיגיטלי במודל CMYK לדפוס אופסט במודל ,RGB למדיה דיגיטלית נשתמש במודל
בהתאם להנחיות בית הדפוס.

הסיבה היא שמסכים מציגים צבעים ב-RGB ואילו מכונות דפוס אופסט מפרידות את הצבעים לסיאן )C(, מג׳נטה 
.)K( ושחור )Y( צהוב ,)M(

הדגשנו ״מכונות דפוס אופסט״ משום שדפוס דיגיטלי, המיועד להדפסה של כמויות קטנות יחסית של עותקים )בדרך 
.RGB כלל, עד 1000 יחידות( יכול גם הוא, לפעמים, להשתמש בצבעי

כפי שהסברנו בתחילת הפרק, ניתן להגדיר צבע חדש בחלון Swatches. בחלון זה אפשר 
לקבוע את מודל הצבע הרצוי )CMYK, RGB וכד׳( .

צבעי פרוצס 	g

כאמור, הצבעים בעבודה המודפסת בדפוס אופסט נוצרים על ידי שילוב של ארבעת צבעי הפרוצס: סיאן, מגנטה, 
צהוב ושחור )CMYK(. כל צבע במודל CMYK שנוצר במסמך מורכב משילוב בערכים שונים של אחוזים מצבעים 

אלה.

בתהליך ההכנה לדפוס עוברת העבודה הפרדת צבעים ל-4 לוחות )לוח עבור כל צבע פרוצס( בעזרתם תודפס העבודה 
הסופית. לאינדיזיין יש חלון שנקרא Separations Preview באמצעותו ניתן לראות את התצוגה המקדימה של 
הפרדות הצבעים. בעצם, אפשר לראות איך יראו הלוחות המופרדים ובאמצעות ריחוף של העכבר מעל לעבודה ניתן 

לצפות בערכי ה-CMYK של כל נקודה בקובץ.
אל חלון זה מגיעים באמצעות הפקודה Window > Output > Separation Preview ובו ניתן להסתיר או לחשוף 
כל אחד מהצבעים. ראשית, יש לעבור למצב של Separations בשדה View ואז ניתן להסתיר או לחשוף כל אחד 
מהצבעים באמצעות לחיצה על אייקון העין שמשמאל לשם הצבע. במידה ובעבודה קיימים גם צבעי ספוט )עליהם 

יוסבר בסעיף הבא(, גם הם יופיעו בחלון זה, שכן כל צבע ספוט במסמך יביא ליצירת לוח נוסף.
בדיקת העבודה בחלון זה לפני שליחת הקובץ לדפוס, יכולה לחסוך הרבה כסף ועוגמת נפש, שכן ניתן לאתר 
באמצעותו צבעי ספוט שהשתחלו לעבודה בטעות או לאתר מלל קטן ושחור שמורכב, בטעות, מארבעת צבעי 

הדפוס )Registration( במקום משחור ״נקי״ )100% שחור(. 

CyanMagentaYellowBlack

אחוזי ה- CMYK בנקודה מסוימת בתמונה

לוח הסיאן מוסתר

לוח המג׳נטה מוסתר



110
פרק 7 / צבע ואפקטים

צבעי ספוט 	g

אפשרות נוספת היא להגדיר את הצבע כ-Spot. להבדיל מצבעי הפרוצס )שדפוס אופסט יפריד לארבעת צבעי היסוד 
שלו(, צבע ספוט יודפס כפי שהוא. זהו צבע מיוחד שהורכב במדויק, עורבב מראש ונארז בפחיות ולכן הדפסה בצבע 
זה תהיה זהה ומדויקת בכל הדפסה מחדש. שימוש בצבע ספוט מייצר לוח הדפסה נפרד ונוסף בתהליך הדפסה 

באופסט ולכן מייקר עלויות. 

מתי כדאי להשתמש בצבע ספוט?

בעבודות בהן רוצים להשתמש באחד/שניים או שלושה צבעים בלבד )וכך חוסכים הפרדה וכסף(.●	
כשרוצים להדפיס צבע מיוחד, כמו זהב/כסף/צבע מטאלי/זרחני שלא ניתן ליצור באמצעות ארבעת צבעי הדפוס.●	
כאשר רוצים להגיע לצבע מדויק, שיהיה זהה בכל מקום בארץ או בעולם בו ידפיסו אותו, לדוגמה - לוגו של ●	

חברה שהצבעוניות שלו מאד משמעותית )אדום קוקה קולה, כתום של אורנג׳, סגול של סלקום וכד׳(.

בדפוס אופסט משתמשים בקטלוגים של צבע שהנפוץ מביניהם הוא 
קטלוג של חברת פנטון )Pantone(. בדומה לצבעים המשמשים 
לצביעת בתים של חברות כמו ״טמבור״ או ״נירלט״, כך גם לפנטון יש 
מניפות צבעים המתייחסות גם לנייר עליו תודפס העבודה. לכל צבע 
במניפה יש מספר. חלקם מסתיים בסיומת C המייצגת את המילה 
Coated )מצופה( והם ישמשו להדפסת צבע פנטון על ניירות בעלי 
ציפוי כמו נייר כרומו. חלקם מסתיימת בסיומת U המייצגת את המילה 
Uncoated )ללא ציפוי( והם ישמשו להדפסה על ניירות ממוחזרים 
ונטולי עץ למיניהם להם אין ציפוי. ההבחנה בין סוגי הניירות מתייחסת 

לריכוזיות הצבע שהנייר מסוגל לספוג.

בתפריט Color Mode אפשר לבחור את ״מניפת״ הצבעים הרצויה וממנה את הצבעים שישמשו את העבודה. 
רצוי מאוד לבחור את צבע הפנטון באמצעות המניפה ולא באמצעות המסך, מפני שצבעי המסך נוטים לזייף מעט. 

במניפה תוכלו לראות את הצבע כפי שיתקבל על הנייר.

)CC Libreries( אחסון צבעים בספריות הענן
לרובנו יש לקוחות קבועים עבורם אנחנו מעצבים מודעות, כרטיסי ביקור, קטלוגים וכדומה. לרוב, יש למותגי הלקוחות 

קבוצות של צבעים קבועים ומזוהים, כמו צבע הלוגו, בהם אנחנו משתמשים בעבודות השונות.

ספריות הענן מציעות לנו דרך יעילה ונוחה לשמור את אותן קבוצות צבעים לשימוש חוזר. היתרון הגדול הוא שניתן 
לעשות בספריות הענן שימוש בין-תוכנתי, כלומר, הן עובדות גם עם אילוסטרייטור ופוטושופ וגם באפליקציות רלוונטיות 
בענן, כך שניתן לקחת מהספריות חומרים שונים כמו צבעים, אלמנטים גרפיים וסיגנונות בכל אחת מהתוכנות וכך 

ליצור אחידות עיצובית במקסימום יעילות.

את ספריות הענן אפשר לשתף בין מספר מחשבים, כך שאם עובדים בסטודיו מספר מעצבים, לכולם תהיה גישה 
אל הספרייה ואם הלקוח ביקש לעדכן את הלוגו או הפונטים במודעה, עדכון הלוגו או הפונט בספרייה יבטיח כי 

כולם יעצבו לפי הפרטים החדשים. הסבר מפורט על כל אפשרויות ספריות הענן, בפרק 14.
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שמירת צבעים בספריות הענן 	g

	1 . .Window - CC Libraries על מנת להוסיף צבעים חדשים, ראשית יש לפתוח את חלון הספריות מתפריט

	2 לאחר מכן, יש ליצור ספרייה חדשה על ידי לחיצה על הכיתוב ״Create new library +״ שבראש החלון או באמצעות .
.Create New Library - לחיצה על סמן התפריט שבצידו הימני-עליון של החלון ובחירה בפקודה הראשונה

	3 בחלון שנפתח יש להקנות שם לספרייה החדשה. ניתן לשמור בספרייה צבעים הנמצאים בחלון Swatches וגם .
ישירות מתוך אובייקט הממוקם באחד העמודים.

	4 על מנת להוסיף צבע מתוך אובייקט יש לסמן את האובייקט וללחוץ על כפתור ה + שבתחתית חלון הספרייה. .
 ,)Stroke color( צבע הקו ,)Fill color( לחיצה עליו מקפיצה תפריט בו ניתן לבחור האם להוסיף את צבע המילוי

.)Add all( או את כולם )Graphic( את האובייקט עצמו

להוספת צבעים לספריית הענן מחלון Swatches, יש לסמן את הצבעים הרצויים ומתחתית 
 Add selected swatches to(  בצד שמאל, להקליק על האייקון ,Swatches חלון

 .)my curent CC Library
ניתן להעביר צבעים במודלי צבע CMYK, RGB, Lab, PANTONE, ANPA ועוד. הצבעים 

יכולים להיות צבעי פרוצס או ספוט. 
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אפקטים
הקניית אפקטים )צל, הבלטה, הילה ועוד( לצורות, תמונות או מלל באינדיזיין היא פשוטה ויעילה במיוחד. האפקטים 
אינם מכבידים על הקובץ, הם ניתנים להעתקה בקלות מאובייקט אחד לאחר והם מאפשרים לשלוט בכל פריט של 

האובייקט בנפרד )הפריט כולו, מילוי, קו ומלל(.

חלון האפקטים 	g

אל חלון האפקטים ניתן להגיע בכמה דרכים:
	●.Window > Effects באמצעות תפריט
	●.Object > Effects באמצעות תפריט
	●. כאשר יש אובייקט מסומן, באמצעות חלון Properties, על ידי לחיצה על האייקון: 
כאשר יש אובייקט מסומן, באמצעות סרגל השליטה העליון, על ידי לחיצה על האייקון הנ״ל.●	

)Blending Modes( שיטות שילוב 	g

שיטות השילוב, בדומה לאלה של אילוסטרייטור ופוטושופ, משלבות בדרכים שונות בין 
צבע האובייקט העליון )תמונה או אובייקט גרפי( לצבע האובייקט שמתחתיו )תמונה 

או אובייקט גרפי(. 

באמצעות שיטות אלו ניתן ליצור צבעוניות חדשה )ומפתיעה( כמו הכהיית צבע, ליצור 
צבע נגדי )במקום אדום - ירוק(, להבהיר את האובייקט ועוד. מרבית שיטות השילוב 
באינדיזיין אינן מתאימות לדפוס אלא למסך בלבד. למעשה, שיטות השילוב הבטוחות 

.Multiply-ו Darken עבור דפוס הן

שיטות שילוב

הסרת כל האפקטים מהאובייקט הסרת האפקטים מהמטרה הנבחרת בלבד 
)Object / Stroke / Fill / Text(

רשימת האפקטים

שקיפות

מרכיבי האובייקט
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להלן מספר דוגמאות לשיטות שילוב:

)Opacity( שקיפות 	g

לחיצה על החץ בצידו הימני של שדה השקיפות, מציגה את המכוון אותו ניתן לגרור שמאלה, 
עד לקבלת מידת השקיפות הרצויה. אפשרות נוספת היא להקליד את ערך השקיפות בשדה.

ערך השקיפות ישפיע גם על אפקטים שהופעלו על הפריט.

MultiplyScreen

Darken Overlay

DifferenceHard Light

Exclusion Lumunosity

 התמונה המקורית
)Normal(
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החלת אפקטים על עצמים  	g

‎ שבתחתית חלון האפקטים נפתח תפריט משנה המציג את  בלחיצה על האייקון 
רשימת האפקטים שניתן להחיל על עצמים. אפקט המוחל על עצם אינו מתערב בתמונה 
המקורית ואינו מכביד על הקובץ בזמן העבודה, להבדיל מהוספת אפקטים בתוכנה לעיבוד 

תמונה, כמו פוטושופ.

כמה דברים שכדאי לדעת לגבי החלת אפקטים על עצמים באינדיזיין:
ניהול האפקטים המוחלים על פריט הוא גמיש ביותר. ניתן לשלוט ולהחיל ●	

על כל מרכיב של האובייקט אפקטים שונים בנפרד: על האובייקט כולו 
כולו )Object(, על קו המתאר )Stroke(, על המילוי )Fill( או על המלל 

)Text( במידה וקיים.
ניתן להחיל אפקט על כל עצם, גם על פריטים שנוצרו בתוכנה אחרת ●	

ויובאו לאינדיזיין.
ניתן להחיל כמה וכמה אפקטים על עצם )אם כי מבחינה עיצובית, לא מומלץ להפריז...(.●	
באמצעות לחיצה כפולה על שם האפקט בחלון האפקטים ניתן לערוך את נתוני האפקט בכל רגע נתון.●	
ניתן להעתיק אפקט מפריט לפריט אחר על ידי סימון הפריט, לחיצה על האייקון   ●	

גרירתו והשלכתו על הפריט החדש. דרך נוספת ויעילה יותר היא לשמר את האפקט או מספר האפקטים שהוחלו 
על פריט בסיגנון אובייקט לשימוש עתידי )על סיגנון אובייקט, בפרק 10 העוסק בסיגנונות(.

הוספת אפקטים 	g

להוספת אפקט יש לבחור את האובייקט ולפתוח את רשימת האפקטים באחת מהדרכים 
שהוזכרו קודם, לדוגמה, באמצעות תפריט המשנה שבתחתית חלון האפקטים, ולבחור 

באפקט הרצוי. 

בחירת האפקט תציג את חלון האפקטים, כאשר האפקט הנבחר מוצג, ובו ניתן להגדיר 
 fx-את מאפייני האפקט. לאחר אישור החלון, בחלון האפקטים, ניתן לראות את סימן ה

שהתווסף בחלון האפקטים.

לפני החלת האפקטים

אחרי החלת האפקטים 
על מילוי וקו

הגדרת 50% למילוי בלבדהגדרת 50% למילוי ולקוללא הגדרת שקיפות
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)Drop Shadow( הטלת צל 	g

זהו כנראה האפקט השימושי והמשומש ביותר בתוכנה. להלן פירוט האפשרויות שבחלון הטלת הצל:

1 Setting for - בתפריט זה ניתן לבחור את החלק של הפריט עליו יוחל האפקט. בדוגמה שלמעלה אין לפריט 	.
קו מתאר או מלל ולכן השתמשנו באפשרות Object, משמע האפקט מתייחס לאובייקט כולו.

	2 Blending Mode - שיטת השילוב של הצל. הצל הינו אפקט המשתמש בשקיפות. הגדרה זו קובעת את דרך .
ההשתלבות בין צבעי האובייקט בעל אפקט הכולל שקיפות לאובייקטים שמתחתיו. זוהי הגדרה שתופיע בכל 

אפקט בעל שקיפות.

	3 Opacity - מידת השקיפות של הצל..
	4 Distance - מרחק הצל מהאובייקט..
	5 Angle - זווית התאורה. הקו שבתוך העיגול מסמל את הנקודה ממנה מגיעה התאורה כביכול, לכן הצל יפול .

בצד הנגדי לה. ניתן לסובב את הקו מסביב לעיגול לקבלת הזווית הרצויה או להזין ערך בשדה שמימין. הערך 00 
מדמה את גובה הקרקע בעוד הערך 900 ממקם את התאורה בקו ישר מעל לאובייקט.

	6 Use Global Light )זווית תאורה אחידה( - סימון אפשרות זו בכל הפריטים בעלי האפקטים במסמך תיצור .
נראות אחידה וריאליסטית.

	7 X/Y Offset - הזזה של הצל לצדדים או למעלה/למטה..
	8 Size - מידת הריכוך של קצוות הצל. .
	9 Spread - מידת ההתפשטות של הצל..

אחרי הטלת צלללא אפקט
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Noise - מידת הגרעיניות של הצל.10	.
Object Knocks Out Shadow - אפשרות זו גורמת לכך שהצל יישאר מאחורי האובייקט ולא ״יעלה״ עליו 11	.

והיא רלוונטית רק כאשר האובייקט לא נמצא ב-100% אטימות או כאשר מוחל עליו עוד אפקט המערב שקיפות. 
כאשר האפשרות מבוטלת הצל יעלה על האובייקט השקוף. במרבית הפעמים נרצה שהאפשרות תהיה מסומנת 

ולכן היא מסומנת כברירת מחדל.

Shadow Honors Other Effects - כשאפשרות זו מסומנת הצל יתאים את עצמו לאפקטים אחרים המערבים 12	.
שקיפות המוחלים על האובייקט. לדוגמה: אם נעשה שימוש באחת מאפשרויות ריכוך הקצוות )Feather( הצל 
יקבל את מידת ריכוך הקצוות של אותו אפקט. האפשרות אינה מסומנת כברירת מחדל, וטוב שכך, מה שמאפשר 

לשלוט בצל באופן נפרד.

)Inner Shadow( צל פנימי 	g

אפקט זה מעניק לאובייקט צל בצידו הפנימי )להבדיל מהצל החיצוני שמעניק ה- Drop Shadow(, יוצר מראה 
של אובייקט ה״חותך״ אובייקט אחר ומייצר אשליית תלת מימדיות.

.Drop Shadow-המאפיינים האפשריים באפקט זה זהים למקביליהם באפקט ב

עם צל פנימי לעיגולללא אפקט
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)Outer Glow( הילה חיצונית 	g

אפקט היוצר הילה מחוץ לאובייקט עליו הוא מוחל.

בחלון ההילה החיצונית ניתן להגדיר את שיטת השילוב של ההילה )Blending Mode - הגדרה זו היא משמעותית 
שכן היא משנה לחלוטין את נראות ההילה בשיטות השילוב השונות(, את הצבע שלה )בדוגמה זו השתמשנו בצבע 
האובייקט לצבע ההילה(, את מידת השקיפות שלה )Opacity(, את מידת ואופן ההתפשטות שלה )Size, Technique( ועוד.

)Inner Glow( הילה פנימית 	g

אפקט היוצר הילה בתוך האובייקט עליו הוא מוחל. בדומה להילה החיצונית, גם בהילה הפנימית ניתן להגדיר את 
צבע ההילה, את שיטת השילוב שלה, את מידת ואופן ההתפשטות שלה, את מידת שקיפותה, את מיקום ההילה 

ביחס לקו החיצוני של האובייקט )Source( ועוד.

עם הילה חיצונית והבלטה ללא אפקט

ללא אפקט

שימוש בהילה פנימית וחיצונית יחד יוצר אפקט ניאון
)Source: Edge( עם הילה פנימית

)Source: Center( עם הילה פנימית
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)Bevel and Emboss( הבלטה ושיפוע 	g

באמצעות משחק עם הבלטה בשיפוע, אור וצל, יוצר אפקט זה אשליה של תלת מימדיות לאובייקט עליו הוא מוחל.

לאפקט זה כמה אפשרויות באמצעותן ניתן ליצור נראות של הבלטה חיצונית והבלטה פנימית המתקבלת כהטבעה. באמצעות 
חלון ההבלטה בשיפוע ניתן להגדיר את סיגנון ההבלטה )Style(, את הטכניקה שלה )Technique( , כיוונה - למעלה או למטה 
)Direction(, גודלה )Size(, מידת הריכוך שלה )Soften(, עומקה )Depth(, זווית התאורה )Angle( ומרחקה מהאובייקט 

)Altitude(, את הגדרות האור )Highlight( ושקיפותו ואת הגדרות הצל )Shadow( ושקיפותו.

)Satin( סאטן 	g

אפקט זה מנסה לדמות מראה של בד 
סאטן רך באמצעות אפשרויות כמו 
שיטת שילוב, זווית התאורה, שקיפות, 

גודל והיפוך הכיוון.
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)Basic Feather( ריכוך קצוות בסיסי 	g

השימוש באפקט זה מרכך את קצוות האובייקט עליו 
הוא מוחל מכל הכיוונים, כך שהאובייקט משתלב 

ברכות של נוצה עם הרקע שלו.

ניתן לשלוט באופן הריכוך באמצעות הגדרות כמו: 
רוחב הריכוך )Feather Width(, מידת כניסת הריכוך 
 )Corners( תצורת הפינות ,)Choke( לתוך האובייקט

.)Noise( וגרעיניות

)Directional Feather( ריכוך קצוות כיווני 	g

בשונה מאפקט ריכוך הקצוות הבסיסי, באפקט זה 
ניתן לשלוט בריכוך מכל כיוון של האובייקט בנפרד 
)Feather widths( כמו גם לשלוט בזווית הריכוך 

)Angle(, בתצורה שלו )Shape( ועוד.

האובייקט המקורי
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)Gradient Feather( ריכוך קצוות הדרגתי 	g

אפקט זה יוצר באובייקט מעבר הדרגתי לשקיפות 
כך שהוא נעלם בהדרגתיות רכה אל תוך הרקע שלו. 
בחלון האפקט ניתן להגדיר את המכוונים שיצרו 
 ,)Gradient Stops( את המעבר ולהפוך את כיוונם
להגדיר להם שקיפות )Opacity( ומיקום מדויק 
 )Type( כמו גם לקבוע את סוג המעבר )Location(

.)Angle( ואת הזווית שלו

 Gradient Feather כלי 	g

בתיבת הכלים, מתחת לכלי מעבר הצבעים ממוקם כלי ה-Gradient Feather באמצעותו ניתן להגדיר את כיוון 
המעבר לשקוף. מומלץ, ראשית, לקבוע בחלון האפקטים )אליו ניתן להגיע גם באמצעות לחיצה כפולה על כלי 
ה-Gradient Feather( את סוג המעבר )קווי או מעגלי(. לאחר אישור החלון יש לבחור את האובייקט ולמתוח ״קו״ 
באמצעות לחיצה וגרירה שיקבע כיוון המעבר )במעבר קווי( ואת נקודת ההתחלה והסיום שלו, בדומה לכלי 

ה-Gradient הרגיל.

באמצעות אפקט זה ניתן גם ליצור שילוב בין שתי תמונות באינדיזיין מבלי לגעת בהן בפוטושופ:

גרירת כלי ה-Gradient Featherהתמונה המקורית

התמונות המקוריות


